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Leopard Tips & Tricks
by Sue Beal

continued on page two

July 9, 7pm, KL Library

Free Web Tools
for groups & organizations

For our July meeting, Karen Beal, 
Diane Marshall and MaryAnne 

Roper have put together a suite of 
free web tools for organizing various 

aspects of your social and service 
life! There are four parts to this one: 
PB WORKS - for building websites
EVITE - for coordinating an event

DOODLE - for schedule coordination
SURVEY MONKEY - for following up.

This should be fun to see, and if you 
are involved in any organizations, 
bring along your co-volunteers. 

These sites are not just for 
Mac users; they’re available to all.

Come at 6:30 for
More Help for Beginners:

New! Beginner’s Circle: bring your 
laptop and your questions at 6:30, 

and for a half-hour prior to the main 
meeting we'll have experienced

folks available to help beginners,       
one on one, or in small groups.

There was such an enthusiastic 
response to Joe Kukella’s Macintosh 
101 presentation in May that I decided 
to fi ll in with more Leopard Tips and 
Tricks in June. There is always more 
we can learn about what our Macs can 
do for us — there are so many areas to 
play with and customize!

I came armed with pages and pages 
of notes, and right away, people in 
the audience began chiming in with 
more tips and tricks! I think everyone 
in the room learned something that 
night! Thank you to everyone who 
contributed!

The order of these tips might seem 
a little chaotic, but it’s all here, plus a 
few that got missed along the way.

 Dock Schlock
Go under the Apple and choose Sys-

tem Preferences, then click the icon for 
Dock. We went through the show and 
Hide options, and the positioning of the 
Dock... all things Joe covered. 

But then we turned on the Animat-
ed Open and the Genie Effect and 
moused over the Dock to show what 
they did. We also saw this cool trick, 
which has no practical use whatsoever: 
hit the yellow button to minimize a 
window while holding down the shift 
key; you get the minimizing effect (Ge-
nie or Scale) in slow motion! Useless 
byt cool!

Red-Yellow-Green
Almost every Mac user knows that 

the Red Button (upper left corner of any 
Window) closes the Window. The Yellow 
Button minimizes the Window, (which 
means it gets small and goes down into 
the Dock on the right hand side). And 
the Green Button causes the Window 
to zoom to full size (hit it again, it goes 
back to the original size). 

But did you know that in iTunes, the 
Green button does something special? 
The Zoom function for the iTunes Win-
dow yields a small control-panel-like 
window that gives you  controls and a 
small display. You can even click again 
on that small window and it will get even 
smaller - cutting out the display part.

Downloading & Installing
New users fi nd this a little confusing, 

so we went over how to download and 
install an application. You click the 
download button on the site and watch 
it come down (it may take a while, the 
fi les can be large.) When it's fi nished 
downloading, you should see a fi le on 
your desktop or in your Downloads 
folder with the .dmg suffi x. (DMG 
stands for Disk Image).

Double click the DMG to open it. 
You’ll something like this:

Pick up the folder and drag it to 
the Applications Folder alias you 
see there. That copies it from the 
disc image, which is temporary, to 
your Applications folder, which is 
permanent. You can then trash the 
DMG (your Trash Can will turn into 
an Eject Symbol - that's because it’s 
pretending to be a disk).

If you want to put the new application 
into the Dock, open your Applications 
folder, locate the application, and drag & 
drop it to the desired spot in the Dock.

To remove something from the 
Dock, just drag it out and drop it. 
You’ll see it go “poof!” and disappear. 

Bonus Tip:

Be selective and careful when 
downloading Applications! Make sure 
you are downloading a solid app from 
a reputable site, and don’t do a whole 

bunch of them at one time; pace 
yourself. That will make it easier to 

fi gure out which one is responsible if 
you start having problems. 

Don’t ever download pirated software; 
you run the risk of infecting your 

computer with a Trojan Horse virus!

You did not really delete it; you only 
deleted an alias (a pointer) to it. This 
happens frequently by mistake! If you 
have lost something that used to be in 
your Dock, fi nd the original application 
or folder and drag it back in!!

Hitting the Trash Can
Do you fi nd it annoying that the Trash 

Can moves when you try to put some-
thing into it? Try highlighting what 
you want to trash, and hit Command 
Delete (Command is the key with the 
Apple and the scrolly thingy on it—hold 
them both down at the same time). It's 
in the trash now!

Safari/Browser Tips
Most new Mac users use Safari as 

their web browser because it comes 
installed. Occasionally, you’ll have 
problems when accessing a particular 
website. It could be your Safari that’s 
the problem! There are two things that 
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Tips & Tricks
continued from page one

continued on page three

IMPORTANT SOTWARE UPDATE TIP:

DO NOT casually update everything 
that Software Update hands you! 
Choose carefully, and when you 
decide to update your operating 

System (Tiger or Leopard), follow the 
steps that Tom Mulhall gave us last 
month. Email me if you need to see 

Tom’s Tips again!!

are easy to try.
First - make sure your Safari is up 

to date by using Software Update (under 
the Apple) to check it.

Second - download and install an 
alternate browser - Firefox is popular 
and free, and so is Opera. Try those 
browsers to see if it’s Safari or the 
website that has the problem.

Where Am I?
Joe showed us how to Command-

click the name of the Window to see 
where that Window fits in the storage 
hierarchy. You can also go to the View 
Menu and choose “Show Path Bar” 
for a permanent bar at the bottom of 
each Window with this information. 

Windows Management
Ever get way too many Windows open 

on your Desktop and lose your way? 
You don’t have to sit there and click 
each one’s Red Button to clean up! You 
have several options:

Command-W closes the active Finder 
window.

Option-Command-W closes all 
Finder windows. Option-clicking the 
Red Button works the same way.

Exposé provides some slick tricks for 
finding what you need in a hurry.

There are 3 Exposé keys:
• F9 - shows you all active Windows, 

shrunk down to fit on your screen
• F10 - Shows you all application 

Windows the same way
• F11 - my personal fav - gets all Win-

dows out of the way and lets you 
see your desktop. Great for finding 
that document you need to attach 
to an email. Find it, click on it, and 
hold down the mouse button while 
you hit F11 and go back to the email 
program... and drag & drop it in!

 By the way, these are the default 
keys set in the system. If you want 
to customize them, go to System 
Preferences > Expose/Spaces > Ex-
pose and set them as you like.

Don’t Forget Dashboard!
F12 brings up your Dashboard Wid-

gets! Click anywhere (not on a Widget) 
to make them disappear.

View Options
Joe showed us all the different views 

that can be used for Windows: Icon, List, 
Column and CoverFlow. But for grins, 
open the View Options (View Menu > 
Show View Options) and click through 
the different views, playing around with 
the settings. You’ll see info available 
that does not come up by default.

Warning: Do not turn on “Calculate 
Size” for any more than a folder or two 
at a time. Having this turned on for a 
lot of folders will cause your computer 
to churn and churn, recalculating the 
folder sizes.

Viewing Shortcuts
In Column View, you can use the four 

Arrow Keys to navigate easily.
In List View you can select multiple 

folders, and then open them by using 
the right arrow key.  As long as they 

HOW DO YOU TYPE THE  EURO SYMBOL ( € )?
Option - shift - 2  - But you need to be using a font that  supports it; TImes New 
Roman works, as does Arial. Look for the accompanying email attachment that 
documents many commonly used special characters. Keep it for reference!

are still highlighted, the left arrow key 
will close them all.

To select multiple files and folders, 
shift-click or command-click them. 
The difference is that shift-click will 
take the folders in between (in List or 
Column Views) and command-click only 
selects or deselects the ones you click 
on directly. Remember, the Command 
Key is the one with the Apple on it.

To open all the folders inside other 
folders in List View, use Option Right 
Arrow. Option Left Arrow closes them 
(if they are still highlighted.)

Opening Documents
There are so many ways!

•  Select it and choose Open from the 
File Menu (boring!)

• Select it and type Command-O
• Double click it
•  Drag it and drop it onto the Appli-

cation icon in the Dock (especially 
good if it does not automatically 
open in the Application you pre-
fer.)

• Last resort - open the Application 
and use the File > Open command 
to try to open it.

Save Time Opening Documents
If you have a type of document in 

your system that does not open with 
the program you'd like (for example, 
your JPGs open in Preview and you'd 
rather open them in Photoshop)  high-
light a document of that type and use 
Command-I to Get Info.

Look down the panel for the “open 
with” section. Click the little triangle 
to open up that section. Choose the 
preferred Application from the popup 
list. Then click “Change All” to make 
all documents of the same type open 
with the chosen program. Close the 
window. 

Want to change something about a 
bunch of documents at once? Select 10 
or more documents and use Command-I 
to Get Info. You get one panel to make 
the changes, but the changes apply to 
all the documents. Fewer than 10 and 
you get individuals panels! Command-
Option-W closes all of them at once 
(this also closes all the open windows 
on your Desktop!).

Google Images
Not a Mac thing, but handy for grab-

bing little pictures to use for custom 
icons and other things. Open Safari or 
your browser of choice, put “puppy” 
or something you’re looking for in the 
search field, and browse for images. 
You'll get tens of thousands of them!
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Tips & Tricks
continued from page two

MU

Digital Photography
& Photoshop CS4

Lessons Available 
Locally

One on One
$75 per hour.

Groups of 3 to 4
$25 pp per hr.

Field Trips Available
$50 pp for 4 hours,

for 4-8 people.

For more info:

Pete Bacheler
305.522.4863

flphoto@me.com
www.photone.net • pbacheler.smugnut.net

Custom Icons
We found a SMALL image of a cute 

puppy to use for a custom icon. You 
want as small a picture as possible, 
since your operating system has to 
handle these pixels every time it is 
displayed (this is a good reason to use 
custom icons sparingly). The puppy you 
see here is available 
in 147k or 28k on 
Google; we used the 
28k one. Here's how 
you make it into an 
icon:

Open the puppy 
picture in Preview. Copy (Command-
C). Go into the Finder and highlight 
the item for which you want a custom 
icon. Command-I to Get Info. Click on 
the icon (top left of the panel). Paste 
(Command-V). Close the panel.

You can make an icon from almost 
anything you can Copy... just remember 
to keep the image size small!

Screen Shots
It is often handy to capture a website 

image or take a picture of something on 
your screen. The captured screen shot 
can be saved, printed, emailed or edited. 
There are a couple ways to do it:
• Command-Shift-3: Takes a picture 

of your whole screen - active window 
and background.

• Command-Shift-4: You see a cross-
hair where the cursor it - drag it 

across what you want to capture. 
Let go and it takes the picture.

• Command-Shift-4: Hit the spacebar 
and the active window highlights. Click 
the mouse button for the picture.

Whichever method you use, after you 
do it you will see a new file on your 
desktop called picturen.png. Those 
PNG files can be opened and manipu-
lated in Preview or Photoshop.

Drag and Drop
This little technique is your friend! 

Highlight a line or two of text. Click on 
a letter and drag & drop it into another 
document, or onto the Desktop, where 
it makes a little document called a text 
clipping. Drag & drop it into an email. 
You can drag and drop both text and 
graphics. When in doubt, just try it!

Contextual Menus
These are available in the Finder; 

Control-Click any icon see what ac-
tions are available to you. 

Quick Alias
Select an item. Hold down Option-

and Command while you pick it up 
and drag it to another folder or your 
Desktop. You’ve just made an Alias 
without that word “alias” appended to 
the name! (See the icon still has the 
little arrow, telling you it's an Alias.)

Size Down Photos For Emailing
Drag the photo into the email. Look 

at the bottom right of the Mail Window. 
Select small, medium or large. This 
resizes the photo(s) you are sending 

without affecting the original. 

Fast CD/DVD Burn
In the Finder go to the File Menu and 

Select New Burn Folder.
See the icon? Drag the items into it 

that you want on your disc (it makes 
Aliases of them). Open the Burn Folder 
and click the Burn Button at the top 
right. Follow prompts to put in a CD 
or DVD and continue.

Speech Options
This is one you just gotta play with! 

Under System Preferences, choose 
Speech. Check out all the voices and 
try turning on the Announce Alerts op-
tion, the Announce When Apps Need 
Attention and Speak Selected Text. Play 
with it! This one is pure fun!

When Things Go Wrong
You can Force Quit an application 

that's hung up, by choosing Force Quit 
from the Apple Menu. But if your Mac 
isn't responsive, try hitting Option, 
Command and Escape all at the 
same time. This also brings up the 
Force Quit Menu. 

For More Tips and Tricks
Go to Apple.com and type “Pro Tips” in 

the search field. Use the resulting screen 
as a jumping off point for tutorials, down-
loads and the tip of the week.

HELP is great on the Mac. If you 
need help with Finder subjects, make 
sure your in the Finder when you go 
to the Help Menu. Type in a key word 
or two and check it out. Application 
Help is also available.
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All About Twitter
Exerpts from Anne P. Mitchell 

at the Internet Patrol

Many people don’t understand what 
Twitter is. Here is a clear, plain English, 
real-world explanation that answers 
the questions “What is Twitter?” and 
“How do I use Twitter?”

First, with all due respect to Twitter 
founders Biz and EV, Twitter is misde-
scribed as “microblogging” - it is more 
accurately described as “one-to-many 
instant messenger.” Instead of “you 
send a message and I see it”, you send 
a message and many people can see 
it. In fact,  anybody who “follows” you 
will see it. 

It’s that simple. If somebody “fol-
lows” you, they see whatever you write. 
If they are not following you, they won’t 
see it (there is one exception, which is 
explained below).

Messages that you write on Twitter, 
by the way, are sometimes known as 
“Tweets”. 

Once you have an understanding of 
Twitter as one-to-many instant mes-
senger, then it’s easy to understand the 
rest. Here is how the various messaging 
functions of Twitter work:

Imagine you are at a big party, and 
you stand in the middle of the room and 
say something, to nobody in particular, 
out loud in the middle of the room.

That’s how it is when you type a 
regular message into Twitter and hit 
Send. The people who follow you may 
or may not be paying attention to you; 
they may or may not hear you.

Now, let’s say that instead, you go 
up to someone at the party, and tap 
them on the shoulder to get their at-
tention, and then say what you want 
to say directly to them.

That’s the same as using “@user-
name” on Twitter. You have their at-
tention and are talking to them, and 
they will hear you, but anybody who is 
around listening can hear it too.

It’s important to note that you don’t 
have to be following someone to send 
them an @ message, and they don’t have 
to be following you. They will still get 
it. (This is the exception mentioned 
above.)

Now, let’s say that you go up to that 
person and whisper in their ear, so that 
only they can hear it. That’s analogous 
to using “D username” on Twitter. Only 
the person in whose ear you are whis-
pering (or, sending a message via “D 
their-username-here”) can hear it.

By the way, the “D” stands for “Di-
rect Message”, and for that reason, in 

Twitter lingo, people will say “DM me”, 
meaning, send me a direct message us-
ing the “D username” function. You 
can only send DMs to people who are 
following you.

It’s important to note that for an @ 
message, there is no space between the 
@ and the username, but for a private 
message, there is a space between the 
“D” and the username.

Sometimes someone whom you are 
following will say something so pro-
found, so funny, so witty, or so dumb, 
that you will want to share it with all 
of your followers. This is known as 
“retweeting”, or, in Twitter lingo, “RT”. 
This is very similar to forwarding an 
email, only instead of forwarding email, 
you are ‘forwarding’ the message to all 
of your Twitter followers.

There is no command for retweeting 
something - you just copy and paste it 
and send it on out as your own mes-
sage. But there is a protocol, and that 
protocol is that you preface the copied 
message with “RT” or “Retweeting” or 
some other words that indicate to your 
followers that you are quoting someone 
else; and you put that someone else’s 
(the person you are quoting) username 
right after the “RT” words, along with 
the @, so that that person will be sure 
to see the message and know that you 
quoted them. 

To recap all of the above, if you want-
ed to just sent out a message saying 
“Check out the cool stuff at The Internet 
Patrol!”, you would simply type that 
into Twitter.

If you wanted to bring it to my atten-
tion, but in public, you would type:

@AnnePMitchell Check out the cool 

stuff at The Internet Patrol!
If you wanted to tell that to me pri-

vately you would type:
D AnnePMitchell Check out the cool 

stuff at The Internet Patrol!
And finally, if it was me who had said 

“Check out the cool stuff at The Internet 
Patrol!” and you wanted to pass that along 
to your followers, you would type:

RT @AnnePMitchell Check out the 
cool stuff at The Internet Patrol!

Finally, the last thing you need 
to know to really jump in and start 
swimming in Twitter, intead of feeling 
over your head, is just what the heck 
all those words with the # in front of 
them are.

The # is known as the “hashtag” - this 
is not a Twitter term, but rather a term 
that has been used in programming for 
years, and has become common usage 
to refer to the # symbol.

The hashtag is used in Twitter to sig-
nal a key word or keyword - something 
that lots of people are talking about 
- and messages that have the #word 
in them are contributing to that topic. 
That way, if you are interested in what 
people are saying about that subject 
on Twitter, you can search for that 
hashtag. 

If I wanted to see what people were 
saying about the situation in Iran, I 
would search for the hashtag “#iran”. If 
I wrote something on Twitter about Iran, 
I would include the hashtag “#iran,”, 
so that others could find it.

By the way, Twitter does not care 
about upper- versus lowercase letters 
- it doesn’t matter to the system whether 
you capitalize something or not, and 
this is true for commands as well. MU
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Google Information
submitted by Eugene Hasiak

This is something you will want to 
have and  use!  I still remember when 
the telephone company charged me 
$1.50 to get a phone number from in-
formation!   My compliments to Google!  
Leave it up to Google to come up with 
something like  this!!!

Here’s a number worth putting in your 
cell phone, or your home phone speed 
dial: 1-800-goog411. 

This is an awesome service from 
Google, and it’s free -- great when you 
are on the road. 

Here’s and example: The voice at the 
other end says, “City and State.”  I say,  
“Garland, Texas.”  He says, “Business, 
Name or Type of Service.”   I say, Fire-
wheel Golf Course.”  He says, “Connect-
ing” and Firewheel answers the phone.  
How great is that?  This is nationwide 
and it is absolutely  free!

Follow the link below and watch the 
short clip for a quick demonstration.

http://www.google.com/goog411 MU

Looking for a Web 
Volunteer!

by Sue Beal

Is anyone interested in revamping 
our UKMUG website and making it 
more interactive, more fun and more 
useful? We have a site - UKMUG.ORG 
- but it is static. We meet the bare 
minimum of what Apple says we 
must have, but we could do so 
much more!

We could have members/attenders 
post questions and tips, hooking up 
their special interest areas...  post 
the past newsletters for anyone to 
download... put up pictures and com-
ments on recent meetings... we could 
do so much with it if someone was 
willing to give us the time. 

Personally I think it would be a 
great project for someone to do with 
iWeb -- to learn as they go! I have been 
thinking about it for some time, but 
even in the slow time for my business 
I can't seem to squeeze in more hours 
to do it myself. Is anyone out there 
willing to try? Contact me!

Graham, thanks for the nudge!

MU

iTunes 
Question 
of the 
Week

submitted by Karen Beal

Q: How do I add the Artist Name 
to a whole album full of songs when I 
bring it into iTunes? This is one where 
it wasn't a commercial album, so it 
didn’t fill in automatically.

A: Click on the song or shift-click 
a group of songs. Use Command-I (get 
info). Go to the Info Tab and fill in the 
fields. Click OK. MU

How to Decipher 
Gmail Gibberish

By J. D. BIERSDORFER, NY TIMES
Sent by Graham Thomas

Published: June 10, 2009

Q. I sometimes get garbled mes-
sages in my Gmail account. Is there 
anything I can do to make these read-
able?

A. To account for the various 
characters and accented letters used 
around the world, different mail sys-
tems use different text encodings. 
When you get a message, Gmail tries 
to guess what encoding the sender 
used so that it can properly open and 
display the message.

If Gmail guesses wrong, you end up 
with a screen full of gibberish because 
the message wasn’t translated prop-
erly from one encoding to the other. 
And you can get gobbledygook if your 
browser’s default text encoding does 
not recognize certain characters in 
the message.

If you get a messed-up message, click 
on the arrow next to the Reply button 
in Gmail and select the “Message text 
garbled?” option. Gmail should then 
open a plain-text version of the mes-
sage in a new window.

If you have consistent problems 
with garbled messages, you might try 
adjusting the text encoding settings of 
your browser to see if it makes things 
anymore readable. Most browser pro-
grams keep the encoding options 
under the View menu. (Stand-alone e-
mail programs also have text-encoding 
settings.)

The Gmail Help site also has tips 
for dealing with garbled file attach-
ments. MU

Check out TopX Tips 
through the Notes Menu!

Google Doodles
submitted by Karen Beal

Check this out! Watch the 
video at http://www.google.com/
doodle4google/doodler.html

Google doodles, the drawings that are 
designed on, around and through the 
Google logo on their home page, have 
long been part of Google’s history. As 
a Google intern in 2000, Webmaster 
Dennis Hwang began celebrating and 
marking worldwide events and holidays 
with doodles. Since then, the work of 
the doodle team has been seen by mil-
lions and reached cult status, with fans 
waiting to see the next creation on the 
Google homepage.
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ONLINE SOURCES FOR MAC HELP:
http://www.macworld.com/mac_help/

http://www.apple.com/pro/tips/
http://www.mactipsandtricks.com/

http://www.apple.com/support/
http://www.mactips.org/

http://www.macosxhints.com/
http://tips4mac.blogspot.com/

http://www.mac-hints-tips.com/
http://www.macfixit.com

MU Classifieds •  MU Classifieds

Call or email Sue if you have 
something to give away or sell! 

Classified ads are free.

The Official Newsletter of the Upper Keys Macintosh Users Group August 1993                   Volume 1, Issue 1

is the official newsletter of the

Upper Keys Mac Users Group
A nonprofit organization devoted to the use (and 
sometimes abuse) of the Macintosh computer. Sub-
scriptions are $25.00 for one year. Contents © 1993 
- 2009 by the Upper Keys Macintosh Users Group 
except where noted. All other rights reserved. 

219 Second St. • Key Largo FL 33037
(305) 451-4601 • ukmug@bellsouth.net

The Upper Keys Humane Society has an 
IMAC COMPUTER FOR SALE. It was 
purchased new last November but has 
never been used. It was purchased for 
bookkeeping and general office use but 
the bookkeeper did not like the payroll 
program (Aatrix) so they decided to go 
back to a PC. The specs are as follows:

OS 10.5.5, 2008, 17" display 

1.893 MHz core 2 duo processor

512 MB memory

149 GBHD

Model FA710LL/A

Applecare Protection Plan

Asking price is $850.00

Contact John Thomas at (305) 451-4516 
if interested

Why Use         
OpenType Fonts?

from Apple‘s website

One of the oldest myths in desktop 
publishing is “never use TrueType fonts 
for professional publishing.” Perhaps 
that was true in the early 90’s, but 
there’s no reason to avoid them now. 
However, there’s an even better type 
of font format you should be using: 
OpenType. OpenType fonts are great 
for a number of reasons:
*  They have just one file per font, elimi-

nating the need to manage separate 
screen and printer font files.

*  They’re cross-platform — you can 
use the same font on Mac & PC.

*  They can contain thousands of 

characters, so you no longer need 
separate expert fonts.

*  They can contain intelligent char-
acters, such as automatic fractions, 
special characters, and character 
pairs that change depending on 
where they appear in a word (such 
as a swash character).

*  They allow OpenType-aware applica-
tions to follow special instructions 
inside the font called glyph variants 
and automatically swap out char-
acters when relevant. For example, 
in a script typeface, the application 
would be smart enough to use one 
kind of “t” when it appears at the 
beginning of a word and a different 
version when it’s in the middle of a 
word (so that it smoothly attaches 
to the letters around it). 

Applications that are not Open-
Type-aware — such as older versions 
of QuarkXPress or PageMaker — will 
still work with OpenType fonts, but 
without the advanced glyph features 
and intelligence.

In an OpenType-aware application, 
the characters you see in this font 
(Adobe Bickham Script Pro) change 
depending on context. Here the “t” and 
“h” characters change form depending 
on whether they’re at the beginning, 
middle, or end of a word. MU

Trivia Question
from Jim Spencer

Here is today’s Apple trivia ques-
tion (in the same vein as last month’s 
meeting....)

What key combination gives one 
the mighty   symbol ?

(See answer at bottom of this 
column.) MU

Shift-option K (but not in every font)

Great 360° Views     
of the Keys!

submitted by Karen Beal

http://www.fla-keys360.com/ Take the 
tour or use the Navigator to see what 
photos they have. Move your mouse 
around to change the view, look up, 
down... amazing! MU


